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Support 

You can visit the HP Software Support web site at: 

www.hp.com/go/hpsoftwaresupport 

HP Software online support provides an efficient way to access interactive technical support tools. As a 
valued support customer, you can benefit by using the support site to: 

• Search for knowledge documents of interest 

• Submit and track support cases and enhancement requests 

• Download software patches 

• Manage support contracts 

• Look up HP support contacts 

• Review information about available services 

• Enter into discussions with other software customers 

• Research and register for software training 

Most of the support areas require that you register as an HP Passport user and sign in. Many also require 
an active support contract. To find more information about support access levels, go to the following URL: 

http://h20230.www2.hp.com/new_access_levels.jsp 

To register for an HP Passport ID, go to the following URL: 

http://h20229.www2.hp.com/passport-registration.html
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HP Enterprise Discovery 

Release Notes 
Software version: 2.50 / October 2007 

This document provides an overview of the changes made to Enterprise Discovery for version 2.50. It 
contains important information not included in the manuals or in the online help. 

In This Version

New Features

Compatibility Note

Obsolete Features 

Documentation Updates

Installation Notes

Enhancements and Fixes

Known Problems, Limitations, and Workarounds
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In This Version 

Introduction 

These release notes are for Enterprise Discovery 2.50. This new version of Enterprise Discovery is the 
upgrade path for users of Enterprise Discovery 2.2x and 2.1.x.  

If you want to see what features have been introduced in previous versions of Enterprise Discovery 
(including versions 2.1.x and 2.2x), you can read the Release Notes for those versions, available on your 
installation CD under bin\documentation.  

License Schema 

Each Enterprise Discovery server can collect data from a maximum of 50,000 discovered devices and 60,000 
devices in total. The port limit is 150,000 ports (whichever comes first). An Enterprise Discovery Aggregator 
can support 50 servers and up to 500,000 devices. 

The Automated Inventory license introduced in Enterprise Discovery 2.20 enables you to purchase inventory 
capability based on the number of devices that you expect to manage. This license replaces the Device 
Discovery and Device Inventory licenses provided in versions of Enterprise Discovery prior to 2.20. If you 
have purchased these two licenses for a previous version, you will have access to all features provided with 
the Automated Inventory license offered with version 2.50. Note that the Automated Inventory license is 
functional but is not yet reflected in the Enterprise Discovery user interface. 

Updated third party components 

• MySQL Enterprise 5.0.44 

• OpenSSL 0.9.8e 
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New Features  
The following features are available in this version of Enterprise Discovery: 

Support for Mobile Devices  

Enterprise Discovery can discover mobile devices. This involves querying the mobile device server, creating 
an inventory of individual mobile devices, and producing related reports.  

Refer to the “Mobile Devices in Enterprise Discovery” chapter in the Reference Guide. 

Support for Agents and Scanners on New Platforms 

Agents and scanners are now supported on HP-UX/Itanium 2 (Integrity servers) – HP-UX 11.23 or above 
(64-bit) and Mac OS X/Intel - Mac OS X 10.4 or above (32-bit).  

Refer to Help > Compatibility Matrix in the Enterprise Discovery Web UI. 

Upgrade Improvements for New Scanner Platforms 

For new scanner platforms, some configuration options will be automatically migrated when you perform an 
upgrade. This is done for the configuration options applying to the new HP-UX and Mac OS X scanner 
platforms. The values of the options for the existing HP-UX (HPPA) are copied into the values for the HP-UX 
(ia64) platform; and similarly from the Mac OS X (PPC) to Mac OS X (x86). These options include the 
following: 

• Scanner configurations under Administration > Discovery Configuration > Scanner Configuration 
Profiles 

• Scanner file name under Administration > System Configuration > Scanner deployment 

If agents from a previous version are already installed, they will have to be uninstalled. An agent upgrade 
will not fix the problem as it will install the wrong agent package. This step can be done automatically by 
Enterprise Discovery by using the agent uninstall option or it can be done manually. 

Integration of Scanner Generator into the Enterprise Discovery Web UI 

The Scanner Generator can now be invoked directly from the Enterprise Discovery Web UI. It is no longer 
installed as a separate client tool as part of the Client Installation.  

However as a result of this integration, the internal encoding of user names and passwords used in the 
scanner configuration when configuring FTP/HTTP off-site scan file locations has changed. The encoding 
change affects only those user names and passwords that contain non-English characters with an ASCII 
code greater than or equal to 128. Scanners or scanner configurations that contain such characters must be 
re-generated. The previous settings can be read from the old scanner or scanner configuration and then the 
user name and password fields must be re-entered again. 
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Scanner Generator Enhancements 

It is now possible to load previously generated scanner configuration settings from the Enterprise Discovery 
Server into the Scanner Generator and use that as a basis for the new scanner configuration. You can 
perform this task when you set up the scanner profile or when running the Scanner Generator. 

Refer to the “Scanner Generator” chapter in the Configuration and Customization Guide and the 
“Configuring the Discovery Process” chapter in the Installation and Initial Setup Guide. 

Also, for improved usability in the Scanner Generator UI, on the Software Data page (for Classic or 
Combined scans) the Drives and Drive Selection tabs are now combined into just one Drives tab. 

Scanner Enhancements 

It is now possible to specify the level of detail to output to the scanner log file when the scanner is running. 
An option has been added to the Update Model panel of the Device Manager that allows you to retrieve the 
scanner log file. Once the scanner log file has been retrieved, a URL link to view the log becomes available 
on the Diagnosis panel of the Device Manager. 

Refer to the “Scanners” chapter in the Reference Guide and the “Using the Device Manager” chapter in the 
Network Data Analysis Guide. 

Installed Application Information from WMI 

It is now possible to collect installed application information from Windows Management Instrumentation 
(WMI). It is recommended that you disable this detection feature if you do not need this information, since it 
requires considerable time and CPU usage. By default, this hardware detection is disabled in the Scanner 
Generator. 

Refer to the “Scanner Generator” chapter in the Configuration and Customization Guide and the “Scanners” 
chapter in the Reference Guide. 

XML Enricher Configuration UI Enhancement 

It is now possible to configure the XML Enricher to use the Installed Application recognition from the Web 
UI under Server > Administration > System Configuration > Scan processing > Application Recognition. 

Improvements to the Application Recognition Engine 

It is now possible to enter more than one install string in the SAI Editor to further refine application 
teaching. 

Refer to the “SAI Editor” chapter in the Scan Data Analysis Guide. 

Additional Windows Vista Support 

It is now possible to install the client tools on Windows Vista systems. To comply with stricter rules enforced 
by Windows Vista, all files that can be modified have been relocated from under the Programs Files directory 
to the following directories under the Enterprise Discovery data directory: 

• SAI files have been moved to the new SAI directory 
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• .ini and other configuration files have been relocated to the Conf directory. 

Bulk Model Update 

It is now possible to execute Update Model actions on multiple devices at the same time. 

Refer to the “How Enterprise Discovery Works” chapter in the Reference Guide. 

Improvements to VMware Information Reporting 

More information about VMware virtual machines is now displayed in the information panel of the Device 
Manager and is also available in VMware inventory reports. 

Improvements to the Scheduler Management UI 

This UI has been re-implemented to include tabs for schedule settings, validation, deletion of schedule, and 
duplication of schedule. Its location has been moved to Discovery Configuration at the level of Configuration 
Profiles and Device Groups to improve usability. 

Documentation 

A new “Frequently Asked Questions and Answers” chapter has been added to the Planning Guide. 

The Discovery Configuration online help has been further enhanced to improve usability of the help system. 

Other Changes 

Rebranding 

• All references to HP OpenView have been removed from the Enterprise Discovery Web UI, directory and 
file names, online help, and the guides. 

• Enterprise Discovery icons and About images are new. 

• There are new thumbnail and thumblink widgets in the footer of the inventory reports. 

Command Change 

The Query Network command in Device Manager and the applet has been renamed to Query Device. 
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Compatibility Note  
The Discovery Configuration import/export feature is not backward compatible. This means that you cannot 
export a 2.20 configuration and import it into the 2.50 server automatically. 
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Obsolete Features 

Network Configuration 

Support for the old Network Configuration, where a user could still configure the discovery process using 
Network Configuration (as opposed to the new Discovery Configuration introduced in release 2.20), has been 
removed from this release of Enterprise Discovery. 

Scanner Generator 

The Always Create Log file checkbox has been deleted from the Saving tab in the Scanner Options dialog in 
the Scanner Generator. The log file is now always created. 

Operating Systems 

Support for Windows NT 4.0 and Windows 95, 98, and ME has been discontinued in the agents and 
scanners. For this reason Windows NT 4.0, 9x/ME platforms have been removed from the administration 
reports and other UI pages.  

Agents installed on Windows 95, 98, and ME can be automatically uninstalled before the upgrade. 
Otherwise, they will have to be manually uninstalled after the upgrade. 

10 



Documentation Updates 
The first page of this release notes document contains the following identifying information: 

• Version number, which indicates the software version. 

• Publish date, which changes each time the document is updated. 

To check for recent updates or to verify that you are using the most recent edition, visit the following URL: 

http://ovweb.external.hp.com/lpe/doc_serv/ 

1 In the Product list, click the product name (for example, Enterprise Discovery). 

2 In the Version list, click the version number. 

3 In the OS list, click the operating system type. 

4 In the document list, click the document title. 

5 To retrieve the document, click Open or Download. 

 To view files in PDF format (*.pdf), Adobe® Acrobat® Reader must be installed on your 
system. To download the Adobe Acrobat Reader, go to the following URL: 

www.adobe.com

The following PDF documents are available in the Enterprise Discovery user interface: 

• Planning Guide  

• Installation and Initial Setup Guide 

• Configuration and Customization Guide 

• Network Data Analysis Guide 

• Scan Data Analysis Guide 

• Reference Guide 

One additional PDF file is available on the install CD at bin/documentation: 

• Legacy Scanners 

 11 

http://www.adobe.com/


Installation Notes 
Installation requirements and instructions for installing Enterprise Discovery are documented in the 
Installation and Initial Setup Guide provided in Adobe Acrobat (.pdf) format.  

If you are upgrading from a previous version, you need to follow these steps: 

1 If you have created your own User SAIs, make sure you back them up manually before uninstalling 
Enterprise Discovery. Refer to the “Upgrading from Enterprise Discovery Version 2.1.x or 2.20” section 
in the “Upgrade and Migration Scenarios” chapter in the Installation and Initial Setup Guide for details. 

2 Save an external backup of your data, if necessary.  

3 Uninstall the old version of Enterprise Discovery, using the Windows “Add/Remove Programs” feature.  

Depending on the version you are upgrading from, delete one of the following directories from the server:  
 
Version 2.1.x: C:\Program Files\HP OpenView\Enterprise Discovery\2.1.* 

Version 2.2x: C:\Program Files\HP OpenView\Enterprise Discovery\2.2* 

4 Reboot the server before you install the new version.  

The uninstall will not delete the Enterprise Discovery Data directory. Rebooting the server will ensure 
that all parts of Enterprise Discovery are removed. 

5 Install the new version and follow the steps in the Installation and Initial Setup Guide. 

If you changed the default location of the Data directory when you installed a previous version, you need 
to ensure that you use the same location when you install the new version.  

  

 Perl, MySQL, Tomcat and Apache are standard parts of the Enterprise Discovery, included with 
each server installation. If you have these components installed already, make sure to remove 
them before installing Enterprise Discovery. You may NOT substitute any other technologies in 
place of the standard installation. 
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Software and Hardware Requirements 

The Enterprise Discovery server can be installed on Windows 2003 Server, Service Pack 1 or Service Pack 2. 
The following table details a variety of scenarios that can help you estimate your server hardware 
requirements. The Disk value is for your data directory. You will require at least 6GB for the Enterprise 
Discovery installation. 

Table 1 – Suggested Hardware Requirements 

Discovered 
Devices 

Inventoried 
Devices Ports A

gg
re

ga
ti

on
 

A
u
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ed

 
In

ve
n

to
ry

 

T
op

ol
og
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Memory 
(GB) CPU* 

Disk 
(GB) 

6,000 5,000 36,000 
 

x  1.5 
1 CPU 
2.4 GHz 25 

6,000 5,000 36,000 
 

x x   3** 
1 CPU  
2.8 GHz 40 

  18,000 15,000 108,000 
 

x  
   2 

2 CPUs or cores 
3.0 GHz 70 

18,000 15,000 108,000 
 

x x 5 
2 CPUs or cores 
3.0 GHz 105 

60,000 50,000 150,000 
 

x  4 
2+ CPUs or cores 
3.6 GHz 200 

60,000 50,000 150,000 
 

x x 7 
2+ CPUs or cores 
3.6 GHz 260 

50,000 50,000 n/a x n/a n/a 2 
2 CPUs or cores 
3.0 GHz 10 

500,000 500,000 n/a x n/a n/a 3 
2 CPUs or cores 
3.6 GHz 50 

* CPU processor speeds are approximate guidelines. Newer CPUs may have lower frequencies but higher 
performance than those shown in the table. HP Enterprise Discovery is a multi-threaded application, and 
benefits from Simultaneous Multi-Threading (SMT) technologies such as Intel® Hyper-Threading. 

** This is for 5 map sessions. If you want to use more than 5 map sessions, you will require more memory. 

 
These requirements are running one XML Enricher. If you plan to run two XML Enrichers, more 
CPUs and more memory may be required. 

 

 
Enterprise Discovery routinely performs many disk access operations. In order to improve 
performance, especially for networks with a large number of devices, it is recommended that you 
use fast access disks such as SCSI. 
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These calculations have been tested as scenarios for maximum disk size on the server.  

For the Inventory license, this includes: 

• Backup Scan Files is enabled (on average, each scan file is 250KB) 

• Generate MIF Files is enabled  

• Delta scanning is enabled 

• Space required for two backups (one stored backup, and one “in process” backup) 

For the Network Topology license, this includes: 

• Statistic Export is enabled (CSV files) 

• 200 users, with each user account saving 10 map configurations files 

• Space required for two backups (one stored backup, and one “in process” backup) 

The Enterprise Discovery client has the following requirements: 

Operating System Windows 2000, XP, 2003 or Vista 

CPU Pentium® III, 500 MHz 

RAM 500 MB (1-3 GB if you will be analyzing a large number of scan files.) 

Disk 100MB required (2GB recommended) 

Java™ Runtime 
Environment 

5.0 or 6.0 
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Enhancements and Fixes 
The following items (identified by error tracking number) were added or fixed in this current software 
release. These items do not include the fixes that were made in the 2.21 release. Those fixes are documented 
in the Release Notes for the 2.21 release. 

Table 2 lists enhancements to existing features or behavior; Table 3 lists problems that were fixed. 

Table 2 – Enhancements 

Number Location Enhancement Description 

14506 Documentation Disk space requirements for managed devices are 
now documented in the Installation and Initial 
Setup Guide. 

16652 Scanners New hardware field (hwScanDuration) has been 
added to the scan file that indicates the time it 
takes to perform a scan. 

17287, 17716 Documentation New Software Library column had been added to 
the Compatibility Matrix indicating the operating 
systems for which data is available, supported, and 
maintained in the master Software Application 
Library. 

17451 Discovery Engine Query Device command now automatically triggers 
VMware discovery. 

17475 Administration > 
Discovery Configuration 

When entering IP addresses for discovery 
configuration, leading and trailing blanks from the 
IP address are automatically trimmed for ease of 
entry. 

17484 Administration > 
Discovery Configuration 

Device Groups main screen of the Discovery 
Configuration now allows sorting by rank. 

17583 Administration > 
Discovery Configuration 

When adding a duplicate Device Type condition to 
a Device Group, a warning note is provided to alert 
you to the duplication. 

17668 Administration > 
Discovery Configuration 

Error messages are now more explicit for errors in 
IP Address format or Subnet mask format. 

17707 Scanner Generator Scanner Generator dialogs have been redesigned to 
support editing using only the keyboard thus 
satisfying accessibility guidelines. 

17711 Scanner Generator Length limitation of the manual deployment 
scanner names has been lifted. 

17728 Administration > 
Discovery Configuration 

Warnings and consistency checks have been added 
to configuration profiles. 
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Number Location Enhancement Description 

17738 Administration > 
Discovery Configuration 

Tables under the Discovery Configuration screens 
now correctly reflect the user preference, namely, 
they allow the user to highlight every other row. 

17784 Administration > Router 
Discovery 

Router discovery can now detect when the SNMP 
agent on the Enterprise Discovery server is not 
configured. In general, more diagnostics are 
provided during router discovery. 

17785 Administration > Router 
Discovery 

The router discovery results screen indicates if 
router discovery is in progress or not. 

17788 Reports Unrecognized file reports that find devices with the 
greatest number of unrecognized files are now 
generated much more quickly. 

17841 Aggregator Inventory extract and import has been scaled back 
from 48 times per day to once a day. 

17871 Documentation Supported Linux operating systems are now 
reported on the Compatibility Matrix by 
distributions. As such, Redhat and SUSE have 
been added to the matrix. 

18177 Reports Windows Vista Readiness Reports now detect 
CD/DVD on Linux/Unix devices. 

18189 MySQL MySQL ODBC connector has been upgraded from 
3.51.11-2 to 3.51.19 to avoid connection issues 
when using the CM Reporting Server. 

 

Table 3 - Problems Fixed 

Number Location Fix Description 

12537 Scanner Generator 
Online Help 

Help topics are now synchronized with Scanner Generator 
dialogs. 

16868 UNIX Scanner Maximum timeout value of five minutes has been introduced 
when running system commands to prevent scanner hangs 
when a system command hangs. 

17058 Internationalization Scanner configuration names can now contain national (non-
English) characters. 

17140 Internationalization Reports now use the language options configured in the 
operating system and will format dates according to those 
options. 

17258 Documentation Process for scan file deletion has been corrected in the 
Installation and Initial Setup Guide. 
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Number Location Fix Description 

17312 Administration > 
Discovery 
Configuration 

There is no longer any long delay when accessing a screen 
under Administration > Discovery Configuration for the first 
time. 

17407 Administration > 
Discovery 
Configuration 

In Discovery Configuration, the Subnet IP Type condition no 
longer allows duplication in equivalent netmask values. 

17459 Administration > 
System 
Configuration > 
Aggregate 
Configuration 

With the Alarms license (only if the configuration option 
“Number of days to keep imported Discovery Database files” is 
set to a value lower than 10 days), scheduled tasks no longer 
run more frequently than they should, and as a result, 
overload the server. 

17491 Administration > 
Discovery 
Configuration 

Browser back button no longer loses the correct navigational 
path when used with Discovery Configuration. 

17501 XML Enricher Scheduler no longer raises a NumberFormatException error 
when parsing the XML Enricher health file for floating 
numbers. 

17502 Aggregate Applet “Run VMware Discovery” action is now disabled when the 
Device is not configured for VMware discovery. 

17514 Administration > 
Discovery 
Configuration 

For a system-defined Virtualization Profile of Discovery 
Configuration, the Associated Groups tables can now be 
sorted. 

   

17526 Network Map Yellow circle now displays as a full circle when you click up 
one level. 

17558 Discovery Engine In some cases, the “Device Group Name” value reported in the 
Device Manager > Diagnostics panel for the Discovery and 
SNNP profile types was incorrect. This problem has been 
fixed. 

17565 Network Map Analyze Services command is now disabled for virtual devices 
when the configuration option to show them on the map is 
disabled. 

17568 Port Manager In the y-axis drop-down menu in the Statistics panel of the 
Port Manager, the menu items referring to thresholds, when 
the Alarms license is not present, no longer appear. 

17581 Administration > 
Discovery 
Configuration 

In some rare scenarios, it was possible to have a situation 
where a new Device Group could not be added. This no longer 
occurs. 
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Number Location Fix Description 

17590 Administration > 
Discovery 
Configuration 

In Discovery Configuration, moving credentials up and down 
in newly added SNMP and Virtualization configuration 
profiles is now taken into account. 

17595 Administration > 
Discovery 
Configuration 

Order of the credentials when creating a profile is now 
preserved. 

17601 Administration > 
Discovery 
Configuration 

Invalid netmask values are no longer allowed. 

17603 Server All stale connections are now automatically deleted according 
to the “stale connection interval” configuration. 

   

17612, 17623 Status > Current 
Settings > 
Discovery 
Configuration 

VMware password hint is now properly displayed in Discovery 
Configuration. 

17613 Reports Correct device label is now printed in the drill down reports 
for Solaris Virtualization. 

17619 Network Map Dragging the map selection marquis now causes the map to 
scroll when you try to select devices (in a package) and the 
mouse is outside the window. 

17626 Administration > 
Discovery 
Configuration 

In Discovery Configuration, it is now possible to disable the 
“VMware discovery interval” property under the 
Virtualization Configuration Profile without explicitly 
entering the value 0. 

17627 Administration > 
Discovery 
Configuration 

In the Activation Screen, the text "permanently removed" has 
been changed to "deactivated" since the devices are not 
removed and can be reactivated in the database. 

17630 Administration > 
Discovery 
Configuration 

When the name of a device group is changed and its contents 
are modified, the Configuration Profiles tab under the 
Activation screen now contains the correct information. 

17638 Administration > 
Discovery 
Configuration 

Number of characters in a profile name is now validated to 
not be in excess of 256 characters. 

17641 Administration > 
Discovery 
Configuration 

When changing the name of device group, it now shows up as 
a change in the activate changes Activation screen. 

17642 Discovery Engine User initiated VMware discovery actions now generate access 
events. 
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Number Location Fix Description 

17646 Scan Device 
Reports 

Scanned Device Reports no longer fail when encountering 
certain special characters in scan files. 

17648 Server Server error after logging in with the "Password expiry:" 
setting no longer occurs. 

17656 Administration > 
Discovery 
Configuration 

Rank order for a device group is now preserved after the user 
navigates to the read-only view of device group. 

17672 Event Browser In Event Browser, Edit > Copy is no longer disabled when 
multiple records are selected. 

17678 Administration > 
Discovery 
Configuration 

In the Activation screen, the messages that are warning 
messages only have been removed from the errors table. 

17697 Linux scanner CD/DVD-ROM drives are now reported as SCSI devices and 
as physical disks on Linux devices. 

17698 Administration > 
Discovery 
Configuration 

Within the Settings tab of the Agent Details screen, the 
enable/disable state of the input/drop-down fields for "Limit 
bandwidth for data transfers" and "Agent automatic upgrade 
schedule" is now consistent. 

17700, 17701  Aggregate Alarm 
Viewer 

Aggregate Alarm Viewer now displays the Update Time 
values. 

17703 Web Services Several field names were corrected that caused exceptions to 
be thrown when trying to set or get port properties. 

17717 Discovery Engine In some rare cases, unmanaged devices would be added and 
deleted continuously. This problem has been corrected. 

17720 Navigation Tree Navigation tree labels are now highlighted when navigating 
the Discovery Configuration pages. 

17754 Status > Current 
Settings > 
Discovery 
Configuration 

Ping interval on the Discovery Configuration page is now 
accurate. 

17758 Administration > 
Discovery 
Configuration 

In some cases, a user defined Configuration Profile or Device 
Group was displayed as a system one. This problem no longer 
occurs. 

17762, 17764 Applet Some patterns used in the date format account preference 
have prevented the applet from starting. This problem has 
been corrected. 

17769 Alarms Viewer SHIFT + arrow key combination now works properly to select 
lines in the Alarm Viewer. 
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Number Location Fix Description 

17774 Status > Current 
Settings > 
Discovery 
Configuration  

In Discovery Configuration, the default order of the rules now 
starts from highest rank. 

17790 Administration > 
Discovery 
Configuration 

Empty scan method names in the scanner profile are now 
handled properly. 

17816 Windows Vista 
Readiness Reports 

In the Windows Vista Readiness drill-down report of display 
properties, the video attributes "32 Bits per Pixel", "DirectX 
9", and "Pixel Shader 2.0 in Hardware" now display as "Yes" 
when all three attributes are present. 

17882 User Interface Error displayed when accessing the About dialog in the Scan 
Data Viewer has been corrected. 

17891 Reports > Alarm 
Summaries > Line 
Utilization 

"Direction" column is now included in the list of report fields 
that are exported in the line utilization reports. 

17894 Aggregate Virtual 
Devices Reports 

Error reported when trying to access the number of virtual 
devices has been corrected. 

17901 Device Manager Improvements have been made to enabling of commands in 
the Update Model menu. The Update Model list of the applet 
and the Update Model panel in Device Manager are now 
synchronized. 

17914 Agent 
Communication 
Server 

Communication with the agents has been optimized. 

17936 Internationalization Even if the thousands (,) and decimal (.) separators are not set 
to “,” and “.” respectively, web UI elements are now displayed 
properly. 

17967 Administration > 
Discovery 
Configuration 

When the computer name contains special characters, the 
Import/Export page no longer generates an error. 

17994 Applet Decimal separator other than “.” used in certain locales no 
longer prevents the applet from starting. 

18000 Find Special characters causing SQL errors in the Find tool search 
string are now handled correctly. 

18003 Alarms Viewer > 
Port 

Open Far Port and Open Line options are now enabled in the 
Alarms Viewer even if the Network Map is not kept open. 
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Number Location Fix Description 

18013 Device Manager, 
Administration > 
Discovery 
Configuration 

Agent and Scanner configuration profiles are now no longer 
shown in the Discovery Configuration GUI or in the diagnosis 
panel of the Device Manager unless the Automated Inventory 
license is installed. In addition, if the Software Utilization 
license is not present, the "Collect utilization" option is also 
not available in the GUI. 

18023 Documentation Note was added to the "Using the Device Manager" chapter of 
the Network Data Analysis Guide about how the Diagnosis 
tools are used with an Aggregator server. 

 

18095 Event Notification When an event time is not specified, the current time is now 
used. 

18147 Reports Scanned devices with no asset data no longer display an 
empty report when they show up in the scanned device detail 
reports of the scanned device summary reports. 

18148 Administration > 
Discovery 
Configuration 

On an Aggregator Server, if you open Discovery Configuration 
on the remote server, the links on the main index page no 
longer access the local server.  

18149 Administration > 
Discovery 
Configuration 

On an Aggregator Server, if you open any Discovery 
Configuration page on the remote server, the server name in 
breadcrumb now comes from the local server instead of the 
remote server. This is consistent with the rest of the UI. 

18150 Administration > 
Discovery 
Configuration 

On an Aggregator Server, the activate button on the 
Configuration Profiles page and the Device Group page of the 
remote server no longer goes to Activation page of the local 
server. 

 

18153 Aggregate Find Selecting record on a remote server which has port 
information no longer generates an error. 

18166 Administration >  
Discovery 
Configuration 

Clicking on the Description column in Device Groups when 
using an imported configuration no longer results in a server 
error. 

18193 Applet Remote Line Manager can now be opened when performing a 
remote find. 

18204 Web Asset 
Questionnaire 

WAQ page is now fully 508-compliant meeting federal 
government requirements for accessibility. 

 21 



Known Problems, Limitations, and Workarounds 

Agents 

• The agent upgrade process on Solaris 9 may take a long time (SCR# 16663). 

• When the Mac OS X agent is running, using the agent installation disk image to upgrade an existing 
agent does not commit the changes until the system is rebooted. Under normal conditions, it is not 
required to upgrade a discovery agent manually. Enterprise Discovery servers automatically upgrade 
agents when required.  The agent installation disk image is used for initial deployment only (SCR# 
17606).  

• On Mac OS X 10.4.10 or above (Intel), there may be a problem with contacting the agent because it can 
be blocked by a firewall. The agent port needs to be enabled manually either via System Preferences > 
Sharing > Firewall or via the XServe administration tool in case of centralized administration (SCR# 
17960). 

• When you install the agent on Windows Vista machines not using the "Administrator" account, the 
firewall exception is not added into the exceptions list (SCR# 18252). 

Scanners 

• In Manual Deployment Mode, the UNIX scanner will not save offsite scan files to an FTP server when 
the user name is specified in the form domain name/user name (SCR# 12893).  

• Automounts are being scanned in HP-UX and Linux systems (SCR# 15950).  

• Time Zone not reported correctly on Linux 2.2 and 2.6 (SCR# 16836).  

• When a user is connected to a machine through a terminal session, the scanner launched in the manual 
deployment mode gets data related to the session rather than the actual video card data. Also, the video 
card and video memory are not detected properly (SCR# 17528). 

• The scanner does not take into account the Files to Scan > Attributes option configured through the 
Scanner Generator (SCR# 17992). 

• The scanner does not take into account the "Only store files smaller than" option for stored files 
configured to be collected from a “Specific directory” in the Scanner Generator (SCR# 18017). 

• In Windows Vista, the scanner does not collect port information (SCR# 18237). 

Viewer 

• Sometimes sorting on Viewer > Software Applications tab may cause data in various columns to be 
mixed up (SCR# 18004). 

Analysis Workbench 

• In File > Load Options > Asset Fields > Add > Text File Extract > Options, whenever the "Treat field as 
a File Name" option is selected, the "Replace invalid characters with" field must be populated as well, 
even if the "Delete invalid characters" option is selected instead.  Otherwise, the “The file ‘Replace 
invalid characters with’ may not be empty” error dialog appears (SCR# 15827). 
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• For files in the root directory, the leading slash is missing from the beginning of the UNIX directory 
structure in AW (SCR# 16838).  

Server Installation 

• When uninstalling Enterprise Discovery on a small server, the uninstaller may not be able to stop the 
database. It may take several tries to uninstall the software (SCR# 14370). 

• After an uninstall, the branding registry keys are leftover (SCR# 15507).  

• Non-ASCII characters used in data directory path name can cause problems during the installation 
(SCR# 16520 and SCR# 17016). 

• Enterprise Discovery with a Network Topology license should not be installed on VMware (SCR# 16524). 

Server 

• If there is a MySQL query that takes too long, Enterprise Discovery will not function properly and you 
may need to restart System Monitor to recover (SCR# 13964). 

• If your server has another service using port 80, the HP Discovery Apache service will not run properly 
(SCR# 14808).  

• An older OpenSSL DLLs in the system PATH can affect the Enterprise Discovery Apache server and 
Perl engines (SCR# 16318). 

• The reports database does not contain the device to device connectivity information (SCR# 18247). 

• When a VMware or mobile server is reactivated, the VMware/mobile discovery workflows are not 
triggered. As a workaround, stop the HP Enterprise Discovery Engine service (SCR# 18271). 

Application Teaching and Recognition 

• The Enterprise Discovery 2.50 SAI does not recognize the Enterprise Discovery 2.21 application. It 
cannot recognize the application because, although Enterprise Discovery 2.50 is considered the next 
release after 2.21, the 2.50 SAI is actually built before the final Enterprise Discovery 2.21 build (SCR# 
18255). 

Web User Interface 

Administration 

• Depending on the licenses, the "Resource/ Environment manage" option in Discovery Configuration may 
not have any effect (SCR# 14388). 

• Clicking on an item under the Administration > Discovery Configuration > Scanner Configurations 
page of a remote server launches the Scanner Generator for the aggregator server (SCR# 17749). 

• The Export functionality of the Discovery Configuration does not work when invoked from an aggregator 
for a remote server (SCR# 18151). 

• In the Discovery Configuration, moving credentials up and down in SNMP, Virtualization, or Mobile 
configuration profiles will be taken into account only after returning to the screen from viewing the 
detailed credential information (SCR# 18236). 
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• The password for the default "demo" account does not conform with the account/password validation 
rules (SCR# 18239). 

• Under Administration > System Configuration > Server Passwords, if the password history flag is set 
to "0", setting the same password on the account does not work when done twice within 5 minutes (SCR# 
18239). 

Reports 

• Sometimes web pages under Reports do not completely render or print source code in Mozilla Firefox. 
Use the refresh button (SCR# 13803).  

Web Asset Questionnaire 

• The UI may show non-printable characters in text fields (SCR# 16285). 

• In Internet Explorer, when connecting to the main page through a proxy server, the "You are connecting 
from" IP address reported will be the IP address of the proxy server not that of the remote computer 
address (SCR# 17870). 

Applets 

• Pasting information in any Find dialog box does not work when using the SHIFT+INS key combination 
(SCR# 16235).  

• The Update Model > Query Device command is not enabled for mobile devices (SCR# 18278). 

Licensing 

Alarms License  

• Alarms-related items are not always hidden (SCR# 16041). 

Integrations 

• UTF8 Enterprise Discovery data may not display correctly when viewed through the Configuration 
Management (CM) Reporting Server 5.10 (SCR# 18273). 

Internationalization 

• The statistics graphs do not use the language options configured in the operation system and will always 
format the dates in English (SCR# 17180). 

• NetBIOS information collected by the network models will be displayed incorrectly if the string has non 
ASCII characters (SCR# 17411). 

• There are several problems with the SAI Editor accepting characters in the Korean code page (SCR# 
18126, SCR# 18127, and SCR# 18126). 

• When non-ASCII characters are used to define Schedules in the Discovery Configuration, the Status > 
Current Settings > Discovery Configuration may display errors when listing the Configuration Profile 
information (SCR# 18144). 
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• Various UI screens (reports, status reports, Device Manager, and so on) format the "day of the month" 
part of the date as Arabic numerals instead of using the language option configured by the operating 
system (SCR# 18218). 
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